Max—10 Font disk instructions

These instructions will let you create new font sets for use with your
Max-10 word processor. A maximum of 14k of memory is allocated for
fonts. Because of their different sizes, the number of fonts which can be
used at one time will vary. Smaller fonts take up less room and thus it
may be possible to put eight or nine fonts in a single font set. There are
two versions of each font: 80 dots per inch (dpi) for the screen display
and low resolution printers and 120 dpi for higher resolution printers.
These are high—density fonts which were created for Max-10 and they
are not compatible with CoCo Max fonts. If you want to create your own
fonts, the Max—10 technical manual ($5 + $4 S&H) has information on
the format used in font storage.

1. Place your font disk #1 in drive 0 and type RUN "FONTS. A list of
the 18 fonts on disk #1 will appear. Press <CLEAR> to switch to the
list for disk #2. You can make up font sets with fonts from both
disks.

2. To the left of each font is a letter. By pressing this letter, you select
or deselect the font. If the font is selected, a "Y" will appear to the
right of the font name; if the font is not selected, an "N" will be
displayed. If there is a dash (=) to the right of a font, this indicates
that there is not enough memory left to load this font.

3. When you have selected all the fonts you want, press <ENTER>.
You will still have an opportunity to go back and change your
selections by pressing <BREAK>.

4. Next, the fonts must be placed in the correct order. This may be
important because Max~10 assigns fonts according to their order in
the Font menu. So if you have a document which is written in
Script, the first font on the Max-10 font menu and you create a new
font set which has Brookhaven as the first font and Script as the
second, when this document is loaded, it will be displayed in the
Brookhaven font, not the Script font. To sort the fonts, just enter the
letter code of the font which is to be moved, and then enter the
letter of the position to which it must be moved. Press <ENTER>
when you have finished.

5. Now that you have the font order correct, you must specify the type
of font set to create. There are two types: Type 1 is used with Max-

10 version 1.0 — the version without columns); type 2 is for Max-10
version 2. Type 1 fonts may only be placed on a Max—10 backup
disk as version 1.0 can only load fonts on startup. Type 2 fonts may

be saved onto any disk. After you specify the type of font set, the
“font assembler will begin to save the set to disk, prompting you to

change disks as necessary.
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The power of choice

As so many thrilled CoCo users already know, the power of
Max-10 simply cannot be beaten by any other CoCo
program. lts versatility and sheer blinding speed still amaze
long-time users. And the variety of fonts supplied outstrips
that on most printers now being sold.

Colorware has developed a varied two-disk set of thlrty SiX
Max-10 fonts in different sizes. These
fonts may be used in various styles
allowed by Max-10. Remember that
fonts and styles can be mixed on the
same line with no extra effort.

v Plain Text

underlined R
superscript cH
Subscript cL

You can now create sets of whatever fonts you may need.
Imagine loading the set of your favorite letter—writing fonts,
then switching to the fonts you like to use for creating club
newsletters. Fonts range from the serious (Fort Worth,
Rome) to the whimsical (Irvine, Swan Song). You will be
amazed at the "personal” quality of Longhand and the
elegant beauty of Ellesmere. Use the larger 24 point fonts for
eye—catching titles and major headings. The 18 point fonts
make excellent subheadings. Twelve point and smaller
usually form the main body of text in documents of all kinds.
Six point Topeka, in particular, can be used to squeeze a
long footnote onto a page.

This set of fonts is now available for $29.95
Call us at (203) 348-9436 Weekdays 9-5 Eastern Time
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Max-10 font disks

The Max-10 extra fonts can be used to create text in many
different styles. This is Fort Worth 10. There are five different

sizes of Ft. Worth (10,12,14,18,24) for use as titles or
if you want to write all your text large.

Century is there for the
elegantly styled headings
demanded of fine prose.

And, of course, for good, down-home solid lifles,
nothing beats Memphis.

Ntencil lends the bold reassurance that vyeowr
text will stand owt on the page.

Futura catches the eye well,
but with a degree of subtlety.

Digital is just the thing for ihat manual you are writing for yous

earthshaling Cobo soffware. LlHE S0 mang DThEF
fonts, we also offer ¢4 points.

fexs wrisfen ja $wan $oag 12 poinf or headjjned N 24
pOjnf 5f0(ld$ ovf 9n d(ly prj(lfed page,

Downsizing a bit, Woodhaven seems well fitted to the quiet
neighborhoed after which it was named.

Prospect is just the thing for easy to read, yet tightly packed text.

‘When Yoy need that lively, oftbeit look, try
ogt oyr San Franeileo font!

These fonts are actual printouts (on a Star NX-1000) reduced 30%

Thames gives pour lifevature that "Olde
Englishe looke".

Ellesmere is greal for squeezing extra text on a page. It's narrow so more

letters fit on a line. Ellesmere 12 point, tWEﬂTg-fDUI’ point and
twenty-four point bold are on the disks.
Lomghand o wondenful Jon distinctve documenta on mayle juat a
agratuna. Jb also comes in 24 point

Hellew o vary gesd. Yow mep oven coler im Rho Istiore
with evegss for e Iatorestimg offeet. Slmel IR ovem
cemes im 16 peimt size.

Turn to Aschean for that light hearted look.
For precise. typewriter-like text, Courier is an excellent
choice.

And of course, Venice will jazz up any words that
need a boost.

For titles or headings, there are a
variety of special Fonts. Brookhaven
iIs greal for a Broadway look.

Frontier boldly stands out in the Oid West fashion.
Athens is especially good for paragraph titles.

The nine point version of Rome is very easy to read, while the
12 point version can be used for emphasis.

Secaitht La good foa faiendly Cetteas ov signatunea, while
Topekn (6 point) mekex for very compact fgatnoting.

Irvine adds that post-modern look. Try it printed on light

pink or beige parchment for that more upscale look. 145

You may have qguessed, it looks great
in 249 points.



MAX FONTS
For CoCo Max LIl and IlI

by W. Bayer & M. Shawaluck
Copyright 1987 Colorware

Max Fonts are a collection of aimost 100 new and different
fonts (or typestyles) for use with your CoCo Max program.
These new fonts can be used in place of the buult in font
set.

All of CoCo Max's styles (bold, italic, etc.) can be used with
the new fonts and the new font names will appear in the
Fonts pull-down menu.

The complete font library consists of four disks, each
“containing 23 or 24 fonts.

Using the fonts with CoCo Max Il

Start CoCo Max as you usually do. Select Assign Drives in
the Files menu. One of the selections in this: dialog box is
the drive number where the font disk will be found. Choose
a free drive if possible, any drive will work.

Put the font disk in this drive.

Select Load Font Set in the Options menu. Each font disk
holds about 24 fonts but the CoCo Max font menu has
room for on|y 14 entries. Max fonts are split.into two
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Fonts can be in the Fonts menu at one time, so two
groups of fonts (A and B) are used.

With 512K systems, the original fonts remain in memory.

" The extra font disk must be in the selected drive when you

choose a font. With: 128K systems the original fonts are on
the work disk. '
To reload the original fonts, select Load Font Set in the
Options menu. Click on ORIGINAL. Remember to use
Assign Drives-to set the correct drive (M for 512K, .0 for
128K).

Pull down the Font menu. You will see the new font names.
These new fonts work the same as the regular ones, and
all Style and Size features work as well.

Using the fonts with CoCo M‘ax I

Load CoCo Max as you normally do. When you want to
load additional fonts, put the font disk in drive 0. Select
Load Page in the File menu. Click on either MAXFONTA or
MAXFONTB. Only 14 Fonts can be in the Font menu at one
time, so two groups. of fonts (A and B) are used. You can
choose ORIGINAL to get the regular CoCo Max fonts back.
Your picture will not be affected.
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Pull down the Font menu and you will see the new font

‘names. These new fonts work the same as the regular

ones, and all Style options: work as well.

Remember to have the Max Font disk in the dnve when
selecting new fonts, and have the CoCo Max disk in the
drive during Cut, Copy, Paste and Clupboard operations.

Using the fonts with CoCo Max | -

While in CoCo Max, click on Quit in the File menu. when
the *OK" prompt appears, type the following:
LOADM"MAXFONTA":RUN

Click on the Fonts menu. You will see the new font names.
Use these fonts the same as you use the regular fonts.

For the other groups of fonts, follow the same procedure,
but replace MAXFONTA with MAXFONTB, MAXFONTGC,
MAXFONTD, MAXFONTE, or MAXFONTF..

To obtain your original fonts, use ORIGINAL instead of
MAXFONTA, and switch back to the regular CoCo Max
disk before selecting the fonts. ;
Cut, Copy, and Paste use the CoCo Max dlSkY Make sure it a
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Using“the*fén‘l""s“With Max-1 O

Max Fonts are not the same as Max=10 fonts and'so they
cannot be used directly. Fonts for Max=10have higher dot
resolution than CoCo Max fonts. If you wish to use these
fonts with Max~10, you must first type the text you need }
while in CoCo Max then save the text as a normal CoCo |
Max picture. After doing this you may paste the plcture into’
Max-10 as any other picture.

Font Descriptions

As with regular CoCo Max fonts, not all possible characters
will be available in all of the fonts. In the following tables, a
"Fuli" character set means the set includes all 91
characters: !"#3$%&'()*+,~./0123456789::<=>7@

ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghqklmnopqrs

tuvwxyz

A "Letters" character set means upper and lower case
letters only.

A "Symbols" character set consists of numbers,
punctuation, and upper case Ietters ~ ,
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“between them. The "<" and ">"

characters are used fo begin and end
the patterns. For the Books font, the

" *(“and.")" characters create the book

Foo
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Max Fonts Set #1
o FontName . - File Name Type - gt ‘?; g
- Digita! Smalt _' i o) (clip Full : 391, ‘ L
" DigtalMedium  DIGT18 - Full igiTe arga, '\
. Digital Large - DIGIT24 Let. -
2L Futura : FUTURA24 . Let: F U'de
*.Grid Small GRID18 ~ Fult - Grid Smuﬂ
- GridLarge GRID24 Sym. .. E?g L
-HAIFA24 . Sym. SHEN
Jeons . ICONST  sym. HNFR
Night Time - NITETIME - ° Sym. ... g
Space Flight = SPACEFLT Sym. Il@.
Tableau TABLEAU - Sym. .
Victory VICTORY ~ Full - BiGHE §iR l ¢
. BabyTeeth Sm.” BTEETH#2 * Full QQWQ QQ G
-+ Baby Teeth-Lg. - BTEETH24" . Sym. 7
Bobo Bold -~ .. BOBOBOLD Sym. , / :
Books ' BOOKS Sym.
Fropim  NGPRNT Rl Wlna b
- Normande Small - NORMAN{2 - Full g gA;' TEETI L‘
Normande Med. - NORMAN1{8  Full :
Normande Large - NORMAN24 :- Sym. BOBO eo"b
Piano = % PIANQ .o Full: AL
Sinaloa " SINALOA .- Sym,
- Sukiyaki SUKIYAKI  Sym. Egtwhoel‘
: . o - Normande Small -
Speclal Notes )
The:Books and Tableaufonts produce . = Nommde } hdium
character shapes with no white space - NORMANDE LG

T

Max Fonts Set #2

Font Name

Flle Name
+ Bloek Up BLOCKUP
“ Harlow Letters .  HARLOW18
_Harlow Symbols HARLOSYM
< Koloss KOLOSS18
T Mahara]ah MARAJAH
- Muskego MUSKEGO
+ ‘Peigriot Small PEIGNT12
PeignotLarge . PEIGNT18
Program Small PROGRM12:
Program Medium ‘PROGRM18
" “Program Large’ - PROGRM24
Rock Pile ROCKPILE
Futura Black Sm. FUTBLK18
. Futura Black Lg. - FUTBLK24
Hang Up HANGUP
Keyboard * KEYBOARD
Liquid Crystal LOXTAL
Moscow Small . . MOSCOW10
Moscow Large MOSCOW24
Orbit ORBIT
Point Out POINTOUT
Printout Small PRTOUT12
Printout Large PRTOUT24
Stop STOP24

- ‘Special Notes
 The Moscow.fonts are renditions of the

Russian (Cryillic) alphabet. The

Type

Sym.
Let.
Sym.
Let.
Sym.

Sym. -

Fult
Full

Sym. . -

Sym.
Sym.
Sym.
Full

Sym.
Sym.
Sym.
Sym.
Full

Let.

Sym.
Sym.
Full

Sym.
Sym.

"keyboard is based on the closest
phonetic equivalent, where possible.
The Muskego and Hang Up fonts
produce characters with no white

BEAEI 07

dradlow
Koloss

o o

Paqrm Large
pnnnnnm MEQILN
PHIJEHHITI LHHEE

ltlra IllackSmall
Fll’l‘lllh\ BLILLG

] : i @@J@J g8
Lie CRYSTAL
Moczon Cuaax

Moczos apre
111
PIRT BT |
L
PHgT;I]UT LPIRDE

quarter and eighth notes at differnt
positions on the staff. The top row
punctuation keys produce the various
rests, the treble clef, etc.

The Banner font produces character
shapes with no white space between
them. The “<" and ">" characters are
used to begin and end the pattern.

e o

==
WELTHR

=

GEUBI0eY
Tl
Tty

create schematic and logic diagrams

directly from the keyboard. Both

 ends, as shown inthe print samples. . SERIEARE spaces between them. The "<" and ">"
R : i : characters are used to begin and end the pattern.
SR The two:Harlow fonts are provided to allow afl of the possnbte characters
- Max Fonts Set #3 ) to be typed. e
" Font Name | Flle Name Type Max Fonts Set #4
Banner 'BANNER24  Sym. ™ g
. Bockiin BOCKINZA Lot Bead FontName ~ FlleName Type AP @I;sh@
. Broadway ‘BROADW18 Let. roadway A ; o e
= ' pollo APOLLO Sym. -
BwayEngraved  BROADENG Sym.  BROADWAY ENGQ Buster BUSTER  Sym. VG“-‘IN"'E"’“‘N
Dot Matrix DOTMATRX Fult Chi CHINATWN 'S -
. ot ,_;.3._ Hatriz inatown HINA ym.
- Music Music  Sym. Cinema CINEMA Sym. Qbonu
- Old English OLDENG18 Full - | * Ebony EBONY  Sym
Pioneer PIONEER ~ Sym. . By Medina MEDINA  Sym. AAADAA
: : ym,
Urban ~URBAN24 ~ Sym,
Xees Small -~ XERXES12 ~ Ful Beal. METAL - 2ym. ﬁETﬁL
Xerxes Medium = XERXESt8 - Sym. Palms PALMS Sym. m
- Xerx.es Large )éERXES% . Sym. Quarter QUARTER  Sym. SUekTeR
g:’:"; " Hi‘-“c ND gm  Yeaed Rome Small ROME12 ~ Full  poosznall
RTLA . Sli SLICES Sym. ! g, b
Script gcmp'r Full ﬁ’\xx(i s”t»k” cﬁ;se crave  rn SLICES
‘Skyline KYLINE . Sym. Coveru ‘
- p COVERUP  Sym.
Star N‘Ight STARNITE. Sym. 2 R CoCo VDG COCOVDG . Sym. m L
g:f;ggi : gﬁm':g; g;g cel.tic Crossfire CROSFIRE" 'Sym. rfﬁm_ RITP
> - LIABTI ALK Electron ELECSYMB Let. -
suwust — sunsurst sym RARTLAKD Mornin Foe o fEmGaarmn:
Thin Man THINMAN ~ Let. 9 bd ~
. . i ’%
Tip Top S Serwer BOMER L RN
Waves waves  sym.  SRELEAR i)
Wottar WOLTAR Sym Square SQUARE Full =]
) - Stamps STAMPS m. o
N 0008 66060 Srame S g ;.;"“mem
peclal Notes ——T ; uura
The Music font can be used to create SIIN(.". Train S TRANN Sym. . q
single part music notation. Each of the s :
. peclal Notes
four rows of keys produce whole, half, The Electron font can be used to

electronics symbols (resistors, capacitors, transistors, etc.) and logic
symbols (AND, OR., inverter, etc.) are available on the various keys.

The Cinema, Stamps and Train fonts produce character shapes with no
white space between them. The "<" and ">" characters are used to
begin and end the pattern, as shown in the print samples.




